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Bab 1. Dasar-dasar Linux
Linux terinspirasi oleh sistem operasi Unix yang pertama kali muncul pada tahun 1969, dan terus

digunakan dan dikembangkan sejak itu. Banyak dari konvensi disain untuk Unix juga ada pada Linux,

dan adalah bagian penting untuk memahami dasar-dasar dari sistem Linux.

Orientasi utama dari Unix adalah penggunaan antarmuka baris perintah, dan warisan ini ikut terbawa

ke Linux. Jadi antarmuka pengguna berbasis grafik dengan jendela, ikon dan menunya dibangun di

atas dasar antarmuka baris perintah. Lagipula, hal ini berarti bahwa sistem berkas Linux tersusun agar

dapat dengan mudah dikelola dan diakses melalui baris perintah.
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1. Direktori dan Sistem Berkas

Sistem berkas Linux dan Unix diorganisir dalam struktur hirarki, seperti pohon. Level tertinggi dari

sistem berkas adalah / atau direktori root. Dalam filosofi disain Unix dan Linux, semua dianggap

sebagai berkas, termasuk hard disks, partisi dan removable media. Ini berarti bahwa semua berkas dan

direktori (termasuk cakram dan partisi lain) ada di bawah direktori root.

Sebagai contoh, /home/jebediah/cheeses.odt menampilkan alur (path) ke berkas cheeses.odt

yang ada di dalam direktori jebediah yang mana ada di bawah direktori home, yang berada di bawah

direktori root (/).

Di bawah direktori root (/), ada beberapa kumpulan direktori sistem penting yang umum digunakan

oleh banyak distribusi Linux lainnya. Di bawah ini adalah daftar dari direktori umum yang berada

tepat di bawah direktori root (/) :

• /bin - aplikasi biner penting

• /boot - berkas yang diperlukan untuk mem-boot komputer

• /dev - berkas device (peranti)

• /etc - berkas konfigurasi, skrip startup, dll (etc)...

• /home - direktori pangkal (home) untuk pengguna

• /lib - libraries sistem

• /lost+found - menyediakan sistem lost+found untuk berkas yang ada dibawah direktori root (/)

• /media - mount (memuat) removable media seperti CD-ROM, kamera digital, dll...

• /mnt - untuk me-mount sistem berkas

• /opt - tempat lokasi untuk menginstal aplikasi tambahan (optional)

• /proc - direktori dinamis khusus yang menangani informasi mengenai keadaan dari sistem,

termasuk proses (processes) yang sedang berjalan

• /root - direktori pangkal untuk root, diucapkan 'slash-root'

• /sbin - sistem biner penting

• /sys - mengandung informasi mengenai system

• /tmp - berkas sementara (temporary)

• /usr - tempat aplikasi dan berkas yang sering digunakan oleh pengguna (users)

• /var - berkas variabel seperti log dan database
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2. Hak Izin

Semua berkas dalam sistem Linux mempunyai hak izin yang dapat mengizinkan atau mencegah orang

lain dari menilik, mengubah atau mengeksekusi. Pengguna super "root" mempunyai kemampuan

untuk mengakses setiap berkas dalam sistem. Setiap berkas memiliki pembatasan akses, pembatasan

pengguna, dan memiliki asosiasi pemilik/grup.

Setiap berkas dilindungi oleh tiga setelan hak izin berikut ini:

• pengguna

berlaku bagi pengguna yang adalah pemilik dari suatu berkas

• grup

berlaku bagi grup yang berhubungan dengan suatu berkas

• lainnya

berlaku bagi semua pengguna lainnya

Di dalam setiap dari tiga setelan hak izin ada hak izin sesungguhnya. Hak izin, dan cara

penggunaannya untuk berkas dan direktori, diuraikan dibawah ini:

• baca

berkas dapat ditayangkan/dibuka

isi direktori dapat ditayangkan

• tulis

berkas dapat disunting atau dihapus

isi direktori dapat diubah

• eksekusi

berkas eksekusi dapat dijalankan sebagai program

direktori dapat dimasuki

Untuk menilik dan menyunting hak izin pada berkas dan direktori, buka Places->Home Folder dan

klik kanan di berkas atau direktori. Kemudian pilih Properties. Info hak izin ada di tab Permissions

dan Anda dapat mengubah seluruh level hak izin, apabila Anda adalah pemilik dari berkas tersebut.

Untuk mempelajari lebih lanjut mengenai hak izin berkas di Linux, baca halaman hak izin berkas

[https://help.ubuntu.com/community/FilePermissions] di Wiki Ubuntu.

https://help.ubuntu.com/community/FilePermissions
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3. Terminal

Bekerja dengan baris perintah tidaklah tugas yang menakutkan seperti yang Anda pikir sebelumnya.

Tidak dibutuhkan pengetahuan khusus untuk mengetahui bagaimana menggunakan baris perintah, ini

adalah program seperti yang lainnya. Semua tugas di Linux dapat diselesaikan menggunakan baris

perintah, walaupun telah ada alat berbasis grafik untuk semua program, tetapi kadang-kadang itu

semua tidak cukup. Disinilah baris perintah akan membantu Anda.

Terminal sering disebut command prompt atau shell. Di masa lalu, hal ini adalah cara pengguna untuk

berinteraksi dengan komputer, dan para pengguna Linux berpendapat bahwa penggunaan perintah

melalui shell akan lebih cepat dibanding melalui aplikasi berbasis grafik dan hal ini masih berlaku

sampai sekarang. Disini Anda akan mempelajari bagaimana menggunakan terminal.

Kegunaan awal dari terminal adalah sebagai peramban (browse) berkas dan kenyataannya saat ini

masih digunakan sebagai peramban berkas, di saat lingkungan berbasis grafik tidak tersedia. Anda

dapat menggunakan terminal sebagai peramban berkas untuk melihat berkas dan membatalkan

perubahan yang telah dibuat.

3.1. Menjalankan Terminal

Untuk menjalankan Terminal pilih Applications->Accessories->Terminal .

3.2. Perintah Umum

Menilik Direktori - ls

Perintah ls (LiSt) melihat daftar berkas dalam suatu direktori.

Membuat Direktori - mkdir (nama direktori)

Perintah mkdir perintah (MaKeDIRectory) untuk membuat direktori.

Mengubah Direktori - cd (/direktori/lokasi)

Perintah cd perintah (ChangeDirectory) akan mengubah dari direktori Anda saat ini ke direktori

yang Anda tentukan.

Menyalin Berkas/Direktori - cp (nama berkas atau direktori) (ke direktori atau nama berkas)

Perintah cp perintah (CoPy) akan menyalin setiap berkas yang Anda tentukan. Perintah cp -r akan

menyalin setiap direktori yang Anda tentukan.

Menghapus Berkas/Direktori - rm (nama berkas atau direktori)

Perintah rm perintah (ReMove) akan menghapus setiap berkas yang Anda tentukan. Perintah rm

-rf akan menghapus setiap direktori yang Anda tentukan.

Ganti Name Berkas/Direktori - mv (nama berkas atau direktori)

Perintah mv perintah (MoVe) akan mengganti nama/memindahkan setiap berkas atau direktori

yang Anda tentukan.

Mencari Berkas/Direktori - mv (nama berkas atau direktori)

Perintah locate akan setiap nama berkas yang Anda tentukan yang ada di dalam komputer.

Perintah ini menggunakan indeks dari berkas dalam sistem Anda untuk bekerja dengan cepat:
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untuk memutakhirkan indeks ini jalankan perintah updatedb. Perintah ini berjalan otomatis setiap

hari, apabila komputer Anda nyala terus setiap hari. Dan perintah ini harus dijalankan dengan hak

akses administratif (lihat Bab 2, Pekerjaan Administratif [8] ).

Anda juga dapat menggunakan wildcard untuk mencocokkan satu atau lebih berkas, seperti "*" (untuk

semua berkas) atau "?" (untuk mencocokkan satu karakter).

Untuk pengenalan lebih lanjut mengenai baris perintah Linux, silakan baca pengenalan baris perintah

[https://help.ubuntu.com/community/BasicCommands] di wiki Ubuntu.

3.3. Pindah ke mode Konsol

Metode umum untuk mengakses baris perintah di Ubuntu adalah dengan menjalankan terminal (lihat

Bagian 3.1, “Menjalankan Terminal” [4]  di atas)

1. Gunaka shortcut Ctrl-Alt-F1 untuk pindah ke konsol satu.

2. Untuk kembali ke mode Desktop, gunakan shortcut Ctrl-Alt-F7.

Ada tersedia enam buah konsol. Setiap konsol dapat diakses dengan shortcut Ctrl-Alt-F1 ke

Ctrl-Alt-F6.

3.4. Menonaktifkan suara tit di mode Terminal

1. Jalankan sesi Terminal, pilih: Applications->Accessories->Terminal dari sistem menu desktop.

2. Edit->Current Profile... . Pilih tab General. Uncheck checkboxTerminal bell.

https://help.ubuntu.com/community/BasicCommands
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4. Penyuntingan Teks

Semua konfigurasi dan setelan di Linux tersimpan di dalam berkas teks. Walaupun biasanya Anda

menyunting konfigurasi ini melalui antarmuka berbasis grafik, sesekali mungkin Anda harus

menyuntingnya secara manual. Geditadalah editor teks default di Ubuntu, yang dapat Anda luncurkan

dengan mengeklik Applications->Accessories->Text Editor di sistem menu desktop.

Kadang-kadang dalam panduan ini, Anda harus menjalankan Gedit lewat baris perintah menggunakan

gksudo, yang akan menjalankan Gedit dengan hak akses administratif, dalam rangka untuk mengubah

berkas konfigurasi.

Jika Anda ingin menggunakan editor teks dari baris perintah, Anda dapat menggunakan nano, editor

teks sederhana yang mudah dipakai. Saat menjalankannya dari baris perintah, selalu gunakan perintah

berikut, untuk memastikan editor tidak memasukkan jeda baris:

nano -w

Untuk informasi lebih lanjut bagaimana menggunakan nano, silakan lihat panduan pada wiki

[https://help.ubuntu.com/community/NanoHowto].

Selain ini ada juga beberapa editor berbasis terminal yang tersedia di Ubuntu, paling populer adalah

seperti VIM dan Emacs. Aplikasi ini lebih kompleks untuk digunakan dibandingkan nano, akan tetapi

lebih handal.

https://help.ubuntu.com/community/NanoHowto
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5. Pengguna dan Grup

Untuk menambah pengguna dan grup ke sistem, Anda dapat menggunakan aplikasi Users And

Groups yang terletak di System->Administration->Users and Groups .

Agar perubahan dapat digunakan Anda perlu logout dan kemudian login kembali

Untuk menambah pengguna, klik pada Add user, isi ruas data kemudian kilik OK. Untuk menyunting

properti dari tiap pengguna, klik tombol Properties yang terletak di jendela utama Users.

Untuk menambah grup baru, pilih tab Groups dan klik Add group. Pilih nama untuk grup baru dan,

jika menginginkan, Anda dapat mengubah nilai default Group ID. Jika Anda mencoba mengganti

Group ID yang telah tersedia, suatu peringatan akan muncul.

Anda dapat menambah pengguna ke grup yang baru dibuat dengan memilih pengguna dari menu

sebelah kiri dan klik tombol Add. Menghapus pengguna sama mudahnya seperti dengan menambah:

pilih pengguna dari menu sebelah kanan lalu klik Remove. Jika Anda sudah siap, klik OK dan grup

baru dengan penggunanya, jika dimasukkan, akan dibuat.

Untuk menyunting properti dari suatu grup, dari dalam jendela utama Groups, pilih nama grup dan

klik tombol Properties.

Untuk menghapus pengguna atau grup dari sistem, pilih grup atau pengguna yang ingin Anda hapus

dan klik Delete.
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Bab 2. Pekerjaan Administratif
Di Ubuntu, karena alasan keamanan, pekerjaan administratif dibatasi kepada pengguna yang memiliki

hak istimewa saja. Akses administratif diberikan kepada pengguna individu, yang dapat menggunakan

perintah sudo untuk melakukan tugas administratif. Akun pengguna pertama yang Anda buat pada

sistem saat instalasi akan, secara default, mempunyai akses ke sudo. Anda dapat membatasi atau

mengaktifkan akses sudo ke pengguna lain dengan aplikasi Users and Groups (lihat Bagian 5,

“Pengguna dan Grup” [7] untuk informasi lebih lanjut).

Ketika Anda menjalankan aplikasi yang membutuhkan hak akses root, sudo akan menanyakan Anda

untuk memasukkan kata sandi pengguna normal. Hal ini untuk memastikan agar aplikasi berbahaya

tidak merusak sistem Anda, dan berfungsi sebagai pengingat bahwa Anda sedang melakukan tugas

administratif sistem yang mengharuskan Anda agar berhati-hati.

Untuk menggunakan sudo pada baris perintah, cukup ketik "sudo" sebelum perintah yang Anda ingin

jalankan. Sudo kemudian akan menanyakan kata sandi Anda.

Sudo akan mengingat kata sandi Anda untuk waktu yang telah diatur. Default-nya sekitar 15 menit,

tetapi hal ini dapat Anda ubah. Fitur ini didisain untuk mengizinkan pengguna untuk melakukan tugas

administratif tanpa terus ditanya kata sandi setiap waktu.

Harap berhati-hati ketika melakukan tugas administratif, sebab dapat merusak sistem Anda!

Beberapa tips lain dalam menggunakan sudo:

• Untuk menggunakan terminal "root", ketik "sudo -i" pada baris perintah.

• Semua alat konfigurasi berbasis grafik di Ubuntu telah menggunakan sudo, jadi aplikasi tersebut

akan menanyakan kata sandi Anda jika dibutuhkan.

• Untuk informasi mengenai program sudo dan penjelasan tentang tidak adanya pengguna root

di Ubuntu, silakan baca halaman sudo [https://help.ubuntu.com/community/RootSudo] di wiki

Ubuntui.

https://help.ubuntu.com/community/RootSudo
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Bab 3. Menambah, Menghapus dan

Memutakhirkan Aplikasi
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1. Apa itu manajer paket?

Untuk menambah atau menghapus aplikasi di Ubuntu, Anda perlu menggunakan package manager.

Ini adalah program untuk menginstal dan meng-uninstall perangkat lunak, dan mencari komponen

yang dibutuhkan oleh setiap perangkat lunak.

Ada tiga buah manajer paket utama yang dapat Anda gunakan di Ubuntu:

• Add/Remove Programs - Cara mudah untuk menginstal dan meng-uninstall program.

• Synaptic - Pengendali dari perangkat lunak dan komponen sistem tingkat lanjut.

• Apt - Untuk Anda yang lebih suka menggunakan Terminal.

Aplikasi diatas tidak dapat digunakan secara bersamaan. Silakan tutup terlebih dahulu dan buka salah

satu saja.

Anda memerlukan hak akses administratif untuk menggunakan program-program tersebut.

• Bab 2, Pekerjaan Administratif [8]
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2. Tambah/Hapus Aplikasi

Dengan aplikasi Add/Remove… dalam menu Applications, Anda dapat menginstal program baru

di Ubuntu. Anda juga dapat menghapus program yang tidak diinginkan. Dan diperlukan hak akses

administratif untuk menggunakan Add/Remove Programs.

• Bab 2, Pekerjaan Administratif [8]

Jika Anda mengetahui nama program yang ingin Anda instal, masukkan ke dalam ruas Search.

Sebaliknya, silakan pilih katergori perangkat lunak yang ada disebelah kiri.

Program yang sudah diinstal akan terlihat tanda cek pada bagian setelah nama. Uncheck program jika

Anda ingin menghapus program itu dari komputer.

Ketika Anda mengeklik Apply atau OK, setiap perangkat lunak baru akan di-download dari Internet,

dan Ubuntu akan melakukan perubahan. Jika Anda tidak mengaktifkan arsip paket online, maka Anda

akan ditanyakan agar memasukkan CD Ubuntu untuk menginstal beberapa paket.

Beberapa perangkat lunak tidak dapat diinstal atau dihapus menggunakan Add/Remove Applications.

Jika tidak dapat menemukan paket yang Anda cari, klik Advanced untuk membuka Synaptic.
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3. Synaptic Package Manager

Synaptic adalah aplikasi manajemen paket tingkat lanjut yang dapat menginstal dan menghapus

setiap paket yang tersedia untuk sistem Anda. Memakai antarmuka berbasis grafik seperti

application>Add/Remove Applications

Untuk meluncurkan Synaptic, dari menu System pilih Administration->Synaptic Package Manager.

Anda memerlukan hak akses administratif untuk menggunakan Synaptic.

• Bab 2, Pekerjaan Administratif [8]

Jika Anda sudah tahu nama paket yang ingin diinstal atau dihapus, klik tombol Search, dan masukkan

nama paket. Anda dapat juga mencari paket melalui deskripsi paket tersebut (sebagai contoh, Anda

dapat menemukan seluruh paket yang mengandung kata “arcade” atau “mathematics”).

Gunakan kategori dibagian kiri untuk menyaring daftar paket. Untuk kembali ke daftar kategori

selesah melakukan pencarian, klik Sections.

Untuk menginstal paket, klik kotak disebalahnya dan pilih Mark for installation. Jika berubah pikiran,

pilih Unmark. Untuk menghapus paket yang sudah diinstal, pilih Mark for Removal.

Jika Anda telah selesai, klik Apply dan Ubuntu akan melakukan perubahan. Jika Anda tidak ingin

membuat perubahan apapun, cukup tutup jendela saja.
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4. Manajemen Paket Melalui Baris Perintah Dengan APT

Jika Anda sudah nyaman menggunakan Terminal, Anda dapat menggunakan apt (Advanced

Packaging Tool) untuk menginstal dan menghapus perangkat lunak. Anda memerlukan hak akses

administratif untuk menggunakan apt.

• Bab 2, Pekerjaan Administratif [8]

Untuk meng-update daftar paket, ketik dalam terminal:

sudo apt-get update

Untuk menginstal seluruh update yang tersedia:

sudo apt-get upgrade

Untuk menginstal paket:

sudo apt-get install paket

Untuk menghapus paket:

sudo apt-get remove paket

Untuk melihat daftar perintah dan opsi apt:

apt-get help

Untuk informasi lebih lanjut, lihat Debian’s apt manual

[http://www.debian.org/doc/user-manuals#apt-howto].

http://www.debian.org/doc/user-manuals#apt-howto
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5. Menginstal Suatu Berkas Paket

Metode yang biasa dipakai untuk menginstal program adalah melalui manajer paket yang akan

dijelaskan dalam bab ini. Tetapi, walaupun arsip paket Ubuntu sangat besar, sangat memungkinkan

jika Anda ingin menginstal paket yang tidak tersedia dalam arsip Ubuntu. Jika ini terjadi, Anda dapat

juga men-download dan menginstal berkas dari situs web lain.

Sangat penting untuk memastikan bahwa setiap berkas yang Anda download berasal dari

sumber yang aman sebelum Anda menginstalnya.

Ada banyak berbagai jenis berkas paket di Linux. Kebanyakan berhubungan dengan manajer paket

untuk distribusi Linux tertentu. Contohnya adalah berkas Paket Debian (berkas .deb), berkas RPM

Package Manager (berkas .rpm), dan Tarballs (berkas .tar.

Bagian ini menjelaskan bagaimana menginstal suatu paket.

Tidak ada jaminan bahwa paket tersebut akan sesuai dengan sistem Anda dan tidak akan

menerima update keamanan jika Anda menginstal berkas ini. Untuk alasan ini, jika Anda

ingin menginstal program, selalu gunakan paket bawaan Ubuntu dari aplikasi yang tersedia

melalui manajer paket, jika memang tersedia.

5.1. Instal/uninstal berkas .deb

Berkas .deb adalah paket Debian. Berkas paket yang berhubungan dengan Ubuntu mempunyai

akhiran .deb karena Ubuntu mempunyai hubungan erat dengan distribusi Debian GNU/Linux.

Anda membutuhkan hak akses administratif untuk menginstal berkas .deb (lihat Bab 2, Pekerjaan

Administratif [8]).

Untuk menginstal berkas .deb, klik dua kali di berkas. Jika Anda ingin menggunakan Terminal, ketik:

sudo dpkg -i package_file.deb

Untuk meng-uninstall berkas .deb, jangan pilih paket tersebut dari manajer paket. Atau dari Terminal,

masukkan:

sudo dpkg -r package_name

5.2. Konversi berkas .rpm ke berkas .deb

Jenis lain dari berkas paket adalah berkas Red Hat Package Manager yang mempunyai akhiran .rpm.

Tidak direkomendasikan untuk menginstal berkas ini pada sistem Ubuntu. Hampir banyak aplikasi

yang sudah tersedia paket .deb Ubuntu. Akan tetapi, jika benar-benar memerlukannya, berkas .rpm

dapat dikonversi ke paket .deb dengan menggunakan program alien.

Dalam terminal, ketik:

sudo alien package_file.rpm
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Jika Anda mendapatkan error “command not found” atau yang lain, silakan instal alien sebelum

mencoba lagi:

sudo apt-get install alien

5.3. Instal tarballs

Berkas dengan akhiran .tar.gz atau .tar.bz2 adalah berkas paket yang dikenal sebagai tarballs dan

banyak digunakan dalam Linux dan Unix.

Jika tidak tersedia paket untuk Ubuntu di semua repositori Ubuntu, Anda dapat menggunakan baris

perintah untuk menginstal dan meng-uninstal berkas Tarball dengan mengikuti instruksi yang ada di

dalam paket.

Tarball sering mengandung source code dari program, dan harus di-compile terlebih dahulu untuk

dapat digunakan. Untuk melakukan hal ini, Anda perlu menginstal perangkat lunak tambahan (lihat

Bagian 1, “Compiler Pokok” [63] ).
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6. Repositori Perangkat Lunak

6.1. Apa itu Repositori?

Ada ribuan program yang tersedia untuk diinstal pada Ubuntu. Program ini disimpan dalam

arsip perangkat lunak (repositories) dan tersedia bebas untuk instalasi melalui Internet. Hal ini

mempermudah untuk menginstal program baru dalam Linux, dan juga sangat aman, karena setiap

program yang Anda instal dibangun khusus untuk Ubuntu dan diperiksa sebelum program tersebut

diinstal. Untuk mengorganisir perangkat lunak, repositori Ubuntu dikelompokkan ke dalam empat

grup: Main, Restricted, Universe, dan Multiverse.

Dasar pemikiran yang digunakan untuk menentukan perangkat lunak mana yang akan masuk kategori

mana adalah berdasarkan dua faktor:

• Tingkat dukungan dari tim pengembangan perangkat lunak yang tersedia untuk suatu program.

• Apakah program tersebut sudah memenuhi Filosofi Perangkat Lunak Bebas

[http://www.ubuntu.com/ubuntu/philosophy].

Informasi lebih lanjut mengenai Repositori yang ada di situs Ubuntu

[http://www.ubuntu.com/ubuntu/components].

CD Instal standar Ubuntu memuat beberapa perangkat lunak dari kategori Main dan Restricted. Bila

sistem Anda terhubung dengan repositori online, akan lebih banyak program perangkat lunak yang

tersedia untuk instalasi. Dengan menggunakan alat manajemen paket yang sudah terinstal dalam

sistem, Anda dapat mencari, menginstal dan meng-update setiap bagian dari perangkat lunak langsung

melalui Internet, tanpa membutuhkan CD lagi.

6.2. Menambah Repositori Tambahan

Untuk menginstal perangkat lunak dari repositori “Universe” atau “Multiverse”:

1. Buka System->Administration->Software Properties .

2. Pilih Add

3. Untuk menggunakan repositori “Universe”, cek bagian Community Maintained (Universe).

Menambah repositori ini berarti semesta Perangkat Lunak Bebas akan tersedia untuk

diinstal pada sistem Anda. Perangkat lunak ini didukung oleh kelompok sukarelawan

dalam Komunitas Ubuntu yang dipilih dengan cermat, tetapi tidak didukung oleh tim

inti pengembangan Ubuntu dan tidak disertakan update keamanan.

4. Untuk menggunakan repositori “Multiverse”, cek bagian Non-free (Multiverse).

Menambah repositori ini berarti perangkat lunak yang digolongkan di dalam non-free

akan tersedia untuk diinstal pada sistem Anda. Perangkat lunak ini mungkin tidak

diizinkan dalam beberapa wilayah yurisdiksi. Ketika Anda menginstal setiap paket dari

repositori ini, Anda harus memastikan bahwa hukum dari negara Anda mengizinkan

penggunaan paket ini. Dan juga, perangkat lunak ini tidak disertakan update keamanan.

http://www.ubuntu.com/ubuntu/philosophy
http://www.ubuntu.com/ubuntu/components


Menambah, Menghapus dan Memutakhirkan Aplikasi

17

5. Klik Close untuk menyimpan perubahan dan keluar.
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7. Update

Terkadang pengembang Ubuntu merilis update fitur dan keamanan untuk aplikasi dan paket dalam

sistem Ubuntu.

Saat update ini tersedia, Ubuntu akan memberitahukan Anda dengan pop-up dan ikon merah dalam

area notifikasi. Untuk meng-update sistem Anda, klik tombol merah, masukkan kata sandi dan klik

OK.

Program Update Manager akan menampilkan update yang tersedia: untuk men-download dan

menginstal update ini klik Install Updates. Ubuntu kemudian akan men-download dan menginstal

update yang tersedia dari Internet.

Ketika Update Manager telah selesai meng-update sistem Anda, tutup jendela pop-up dengan tombol

Close, kemudian tutup Update Manager untuk menyelesaikan update sistem Anda.

Setelah menginstal beberapa update penting, mungkin diperlukan untuk me-restart komputer

Anda. Jika perlu, Ubuntu akan memberitahukan dengan popup dan ikon dalam area

notifikasi Anda.
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Bab 4. Musik dan Video
Bagian ini menerangkan pemutar musik dan video yang tersedia untuk digunakan dalam Ubuntu dan

bagaimana mengkonfigurasi agar dapat mendengarkan berbagai jenis berkas multimedia.
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1. Memutar dan Mengorganisir Berkas Musik

Untuk memutar dan mengorganisir musik, di Ubuntu terdapat Rhythmbox Music Player, mirip

dengan iTunes. Saat Anda pertama kali menjalankan Rhythmbox, aplikasi ini akan memindai

direktori home Anda untuk mencari berkas musik dan menambahnya ke dalam database. Untuk

menjalankan Rhythmbox, pilih Applications->Sound & Video->Rhythmbox Music Player .

Ubuntu tidak mendukung secara langsung format MP3, karena dibatasi oleh paten dan hak cipta

yang proprietary. Sebagai gantinya Ubuntu mendukung format Ogg Vorbis, sebuah format yang

sepenuhnya bebas, terbuka dan tidak memiliki paten. Berkas Ogg Vorbis juga terdengar lebih baik

daripada berkas MP3 dan telah didukung oleh banyak pemutar musik portabel.

• Pemutar yang bekerja denga Vorbis [http://wiki.xiph.org/index.php/PortablePlayers]

Anda masih dapat memutar berkas MP3 lama Anda dengan menginstal dukungan MP3 (lihat

Bagian 5, “Codec Multimedia” [24] ). Informasi mengenai format lain, seperti Windows

Media Audio (wma/wmv) dan format yang dibatasi oleh paten dapat ditemukan pada Wiki Ubuntu

[http://wiki.ubuntu.com/RestrictedFormats].

Editor untuk tag ID3 Cowbell dapat menyunting metadata pada mp3 Anda dan berkas musik lainnya.

Untuk menggunakan Cowbell:

1. Install the cowbell package from the “Universe” repository (see Bab 3, Menambah, Menghapus

dan Memutakhirkan Aplikasi [9]);

2. Untuk menjalankan Cowbell, pilih Applications->Sound & Video->Cowbell Music Organizer.

http://wiki.xiph.org/index.php/PortablePlayers
http://wiki.ubuntu.com/RestrictedFormats
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2. Memutar dan Mengekstrak CD Audio

Ketika Anda memasukkan CD audio, pemutar dan ripper CD Sound Juicer akan terbuka secara

otomatis. Untuk memutar CD, klik tombol Play atau tekan Ctrl-P. Untuk memutar track tertentu, klik

dua kali pada track atau pilik track dan klik Play.

Untuk mengekstrak (rip) CD audio, pastikan track yang ingin Anda rip sudah terpilih, kemudian klik

tombol Extract atau tekan Ctrl-Enter.

Jika Anda terhubung dengan internet, Sound Juicer akan mengambil informasi seperti nama

artis, judul dan data track dari MusicBrainz.org [http://musicbrainz.org], situs database dari

lebih dari 360,000 albums yang dikelola oleh komunitas.

Untuk menjalankan Sound Juicer secara manual, pilih Applications->Sound & Video->Sound Juicer

CD Extractor.

Anda dapat menggunakan jendela preferensi untuk mengubah tempat penyimpanan berkas audio yang

diekstrak, nama berkas, dan format berkas dan codec yang digunakan. Dalam jendela utama, pilih

Edit->Preferences.

Sound Juicer dapat mengekstrak berkas audio menjadi format berikut:

• Ogg Vorbis -Format lossy audio compression yang bebas paten, dan menghasilkan kwalitas suara

yang lebih bagus dan kompresi yang lebih tinggi dibanding MP3.

• Lebih lanjut mengenai Vorbis di vorbis.com [http://vorbis.com/faq/]

• FLAC - The Free Lossless Audio Codec. Dapat mengkompres berkas audio hingga 50% tanpa

menghapus informasi apapun dari stream audio.

• Situs Web FLAC [http://flac.sourceforge.net/]

• WAV - Biasa digunakan untuk rekaman suara. Sound Juicer menggunakan format ini untuk

berkas audio mono berkwalitas rendah.

Anda juga mengekstrak berkas CD audio ke format tidak bebas MP3. Penjelasan bagaimana me-rip

menjadi format MP3 ada dalam bantuan untuk Sound Juicer. Pilih Help->Contents dan lihat di bagian

Preferences.

http://musicbrainz.org
http://vorbis.com/faq/
http://flac.sourceforge.net/
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3. Membakar CD

Ketika Anda menaruh CD kosong ke dalam CD/DVD-ROM sebuah dialog akan keluar menanyakan

apakah Anda ingin membakar CD audio atau data. Mengeklik di Burn Audio CD akan meluncurkan

Serpentine. Untuk menambah musik ke CD audio, bisa dilakukan dengan men-drag musik dari

Peramban Berkas atau menggunakan tombol Add. Anda juga dapat memilih besar kapasitas CD (21,

74, 80 atau 90 menit). Serpentine memberikan peringatan jika Anda melebihi batas yang ditentukan.

Untuk membuat CD foto atau CD data, klik Burn Data CD. Ubuntu akan membuka jendela CD/DVD

Creator. Aplikasi ini sudah menjadi satu dalam File Browser, dan Anda dapat menambah setiap

berkas atau folder yang Anda miliki izin untuk mengaksesnya. Ketika sudah siap untuk membakar

CD, silakan klik Write to Disc. Ubuntu akan menanyakan drive mana yang memuat CD kosong, dan

memberikan Anda kesempatan untuk menamai CD dan memilih kecepatan tulis. Setelah selesai, klik

Write untuk membuat CD foto atau CD data.
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4. Memutar Video

Untuk memutar video, di Ubuntu telah tersedia Totem Movie Player, yang mirip dan berfungsi seperti

Windows Media Player. Fitur yang dimiliki oleh Totem meliputi custom playlists and DVD playback.

Anda dapat menjalankan Totem dengan mengeklik: Applications->Sound & Video->Movie Player

dari sistem menu desktop.

Untuk membaca berkas video, Totem menggunakan kerangka Gstreamer. Untuk memutar beberapa

format video lain, Anda mungkin harus menambah plugin codec lainnya (lihat Bagian 5, “Codec

Multimedia” [24] ).

Ada juga tersedia aplikasi multimedia lainnya. Contohnya seperti Mplayer, Xine dan Totem-xine

(yang menggunakan kerangka Xine, daripada kerangka Gstreamer framework). Silakan mencoba

untuk merasakan keuntungannya.
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5. Codec Multimedia

Banyak aplikasi dalam Ubuntu yang menggunakan kerangka multimedia open source GStreamer.

Plugin codec untuk GStreamer diorganisir ke dalam paket yang berbeda tergantung dari lisensi yang

dipakai oleh codec tersebut. Anda dapat melihat codec apa yang terkandung di dalam suatu plugin

pada situs web GStreamer [http://gstreamer.freedesktop.org/documentation/plugins.html].

Aplikasi yang lain, seperti Mplayer dan Xine, tidak menggunakan kerangka Gstreamer. Karena

pembatasan pada paten dan hak cipta, codec untuk program ini tidak disertakan sama sekali dalam

Ubuntu. Untuk informasi lebih lanjut mengenai hal ini Anda dapat membaca halaman wiki Restricted

Formats [https://help.ubuntu.com/community/RestrictedFormats].

Menginstal codec tambahan untuk Gstreamer:

• Instal paket berikut dari repositori “Universe” dan “Multiverse” (lihat Bab 3, Menambah,

Menghapus dan Memutakhirkan Aplikasi [9]):

gstreamer0.10-plugins-ugly

gstreamer0.10-plugins-ugly-multiverse

gstreamer0.10-plugins-bad

gstreamer0.10-plugins-bad-multiverse

gstreamer0.10-ffmpeg

        

Anda perlu menggunakan Synaptic Package Manager untuk menginstal paket ini.

Beberapa codec dari paket ini mungkin tidak diizinkan dalam beberapa negara:

sebelum menginstal pastikan dahulu Anda mempunyai izin untuk menggunakannya.

http://gstreamer.freedesktop.org/documentation/plugins.html
https://help.ubuntu.com/community/RestrictedFormats
https://help.ubuntu.com/community/RestrictedFormats
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6. Menggunakan iPod

Anda dapat memutar langsung musik dari iPod dengan Rhythmbox Music Player. Cukup colok iPod

ke komputer, dan buka Rhythmbox.

Untuk mentransfer berkas musik ke dan dari iPod, Anda dapat menggunakan gtkpod:

1. Instal paket gtkpod dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan gtkpod, choose Applications->Sound & Video->gtkpod.
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7. Menyunting Berkas Audio

Audacity adalah perangkat lunak bebas dan open source yang dapat digunakan untuk merekam dan

menyunting suara. Untuk menggunakan Audacity:

1. Instal paket audacity dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan Audacity, choose Applications->Sound & Video->Audacity.

3. Bantuan lebih lanjut untuk menggunakan Audacity, silakan lihat menu Help di Audacity.
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8. Memutar DVD

Pemutar film yang tersedia dalam Ubuntu mempunyai kemampuan untuk membaca DVD yang tidak

dienkripsi. Akan tetapi, kebanyakan DVD komersial dienkripsi dengan CSS (the Content Scrambling

System) dan pada saat ini demi alasan hukum tidak memungkinkan untuk menyertakan dukungan

pada jenis DVD ini dalam Ubuntu. Akan tetapi Anda dapat mengaktifkan dukungan pada jenis DVD

ini dengan cara berikut:

Status hukum dari library ini tidak jelas. Di beberapa negara sangat mungkin penggunaan

library ini untuk memutar atau menyalin DVD tidak diizinkan oleh hukum. Pastikan bahwa

Ada memiliki hak untuk menggunakannya.

1. Instal paket libdvdread3 (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

Anda harus menggunakan Synaptic Package Manager untuk menginstal paket ini

2. Untuk mengaktifkan DVD decryption, ketik baris berikut di dalam terminal:

sudo /usr/share/doc/libdvdread3/install-css.sh

3. Untuk memutar DVD dengan Totem, Anda harus menginstal beberapa codec tambahan (lihat

Bagian 5, “Codec Multimedia” [24]).

4. Akan tetapi, kerangka Gstreamer (digunakan oleh Totem) tidak mendukung menu atau subtitle

untuk pemutar DVD. Karena alasan ini, Anda dapat menginstal pemutar DVD lainnya,

sepertiXine yang mendukung fitur tersebut. Untuk menginstal Xine, instal paket gxine dari

repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

5. Anda dapat membuka gxine dari menu Sound & Video.
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9. Mem-backup DVD

Ada dapat mem-backup DVD menjadi berkas atau ke cakram DVD+/- dengan DVD::RIP. Untuk

menginstal DVD::RIP:

Sebelum mem-backup DVD, pastikan bahwa hukum mengizinkan Anda untuk membuat

salinan ini.

1. Instal Codec Multimedia (lihat Bagian 5, “Codec Multimedia” [24]).

2. Mengaktifkan DVD video playback (lihat Bagian 8, “Memutar DVD” [27]).

3. Instal dvdrip dan transcode dari repositori “Multiverse” (lihat Bab 3, Menambah, Menghapus

dan Memutakhirkan Aplikasi [9]).

4. Anda dapat menjalankan progam menggunakan perintah dvdrip (lihat manual menjalankan

aplikasi [ghelp:user-guide#tools-run-app] untuk bantuan bagaimana menjalankan aplikasi tanpa

melalui menu). Jika menginginkannya, Anda dapat menambah entri menu untuk program dvdrip

(lihat manual penyuntingan menu [ghelp:user-guide#menu-editor] untuk bantuan bagaimana

menambah entri menu). Kami sarankan agar Anda menempatkannya di dalam menu Sound &

Video, dan menggunakan berkas /usr/share/perl5/Video/DVDRip/icon.xpm untuk ikonnya.

5. Untuk menjalankan dvd::rip, pilih Applications->Sound & Video->dvd::rip.

ghelp:user-guide#tools-run-app
ghelp:user-guide#tools-run-app
ghelp:user-guide#menu-editor
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10. RealPlayer
1. Instal paket realplay dari repositori Commercial (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan RealPlayer, choose Applications->Sound & Video->RealPlayer 10.
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11. Penyuntingan Video

Kino adalah editor video tingkat lanjut. Beberapa fiturnya adalah integrasi yang baik dengan

IEEE-1394 untuk men-capture video, kontrol VTR, dan merekam kembali ke kamera. Kino

men-capture video ke cakram padat dalam format Raw DV dan AVI, dengan encoding type-1

DV dan type-2 DV (stream audio terpisah). Untuk informasi lebih lanjut, lihat situs web Kino

[http://www.kinodv.org/article/static/2]. Untuk menggunakannya:

1. Instal paket kino (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan Kino, choose Applications->Sound & Video->Kino Video Editor.

Anda juga dapat mencoba editor video PiTiVi dengan menginstal paket pitivi dari repositori

“Universe” (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]). PiTiVi adalah

editor video untuk desktop GNOME. Walau aplikasi ini masih dalam tahap pengembangan awal,

tetapi layak untuk Anda coba.

http://www.kinodv.org/article/static/2
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Bab 5. Internet
Bagian ini menguraikan beberapa tugas yang berhubungan dengan internet, termasuk bagaimana

terhubung ke internet, mengkonfigurasi dan menggunakan browser internet, dan menggunakan

program internet lainnya.
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1. Menghubungkan ke Internet

1.1. Prosedur Dasar

Bagian ini menerangkan prosedur dasar untuk menghubungkan ke internet.

Jika Anda memiliki koneksi nirkabel, atau terhubung ke internet melalui modem (termasuk

modem ADSL ), dan bagian ini tidak bekerja, Anda dapat membaca Bagian 1.2, “Kartu

Nirkabel” [32]  or Bagian 1.3, “Koneksi ADSL” [34] .

Untuk menghubungkan ke internet:

1. Buka System->Administration->Networking.

2. Pilih koneksi yang ingin Anda gunakan, kemudian klik Properties.

3. Pastikan untuk mengaktifkan Enable this connection.

4. Jika ISP atau admin jaringan memberikan Anda alamat IP, atur Configuration menjadi Static

IP address, kemudian masukkan alamat di ruas IP address dan klik OK. Bila sebaliknya, atur

Configuration menjadi DHCP dan klik OK.

5. Untuk mengaktifkan atau menonaktifkan koneksi jaringan, pilih koneksi Anda, kemudian klik

Activate/Deactivate.

1.2. Kartu Nirkabel

Sudah banyak kartu nirkabel yang terdeteksi secara otomatis oleh Ubuntu saat instalasi. Untuk

melihat apakah kartu Anda sudah didukung, silakan buka System->Administration->Networking.

Jika kartu nirkabel Anda sudah ada didaftar, silakan ikuti Bagian 1.1, “Prosedur

Dasar” [32]  untuk menghubungkan ke internet. Daftar lengkap mengenai kartu

nirkabel yang bekerja dengan Ubuntu dapat ditemukan online pada Wiki Ubuntu

[https://help.ubuntu.com/community/WifiDocs/WirelessCardsSupported]. Silakan tambah entri kartu

nirkabel ke daftar tersebut jika kartu Anda bekerja di Ubuntu.

Beberapa kartu mungkin tidak berkerja secara otomatis dengan Ubuntu. Untuk kasus ini, silakan lihat

Panduan Permasalahan Nirkabel [https://wiki.ubuntu.com/WirelessTroubleshootingGuide] pada

Wiki Ubuntu yang merupakan tempat pembahasan masalah seputar kartu nirkabel.

Jika kartu nirkabel Anda tidak bekerja pada Ubuntu, Anda harus melakukan sedikit penelitian

dalam rangka mengaktifkan kartu nirkabel itu. Cara untuk membuat agar kartu nirkabel menjadi

bekerja adalah menggunakan perkakas ndiswrapper yang mengizinkan Ubuntu untuk menggunakan

driver Microsoft Windows untuk kartu nirkabel. Untuk melakukan hal ini, ikuti instruksi dalam

Bagian 1.2.1, “Driver Nirkabel Windows” [33] .

Seluruh informasi lain mengenai networking nirkabel pada Ubuntu tersedia pada Pusat Networking

Nirkaber [https://help.ubuntu.com/community/WifiDocs] di wiki Ubuntu.

https://help.ubuntu.com/community/WifiDocs/WirelessCardsSupported
https://wiki.ubuntu.com/WirelessTroubleshootingGuide
https://help.ubuntu.com/community/WifiDocs
https://help.ubuntu.com/community/WifiDocs


Internet

33

1.2.1. Driver Nirkabel Windows

Meski jika kartu nirkabel Anda tidak memiliki driver untuk Linux, Anda masih dapat membuatnya

bekerja dengan ndiswrapper. Ndiswrapper adalah modul Linux yang mengizinkan Ubuntu untuk

menggunakan driver Windows untuk kartu nirkabel (dalam banyak kasus).

Instruksi ini hanya berguna pada Ubuntu untuk arsitektur x86 dan AMD64, dan bukan

Ubuntu untuk Power PC (PPC).

Jika memiliki akses internet, Anda dapat melihat apakah kartu nirkabel

Anda sudah didukung oleh ndiswrapper pada situs web ndiswrapper

[http://ndiswrapper.sourceforge.net/mediawiki/index.php/List].

Untuk menginstal ndiswrapper, instal paket ndiswrapper-utils (lihat Bab 3, Menambah, Menghapus

dan Memutakhirkan Aplikasi [9]). Paket ini tersedia di CD Ubuntu. Jika memiliki akses ke internet,

Anda dapat juga menginstal perkakas tambahan berbasis grafik, ndisgtk dari repositori Universe (lihat

ghelp:add-applications#extra-repositories).

Dalam rangka menyetel ndiswrapper, sangat penting untuk mendapat driver Windows

untuk kartu nirkabel Anda. Biasanya, dapat diperoleh dari CD driver untuk kartu nirkabel.

Anda harus menyalin dua berkas ke tempat sama dalam komputer, berkas satu berakhiran

.SYS dan berkas satu lagi berakhiran .INF. Jika Anda menemukan berkas yang berakhiran

.BIN, cukup salin berkas tersebut. Jika Anda tidak dapat menemukan berkas yang tepat, dan

mempunyai akses ke internet, Anda bisa memperoleh bantuan dari situs web ndiswrapper

[http://ndiswrapper.sourceforge.net/mediawiki/index.php/list].

Jika Anda menginstall perkakas berbasis grafikndisgtk, untuk menyetel ndiswrapper, cukup pilih

System->Administration-> Windows Wireless Drivers dari menu dan ikuti instruksi yang diberikan.

Jika Anda tidak menginstall perkakas berbasis grafik, gunakan prosedur ini:

1. Buka Applications->Accessories->Terminal dan ketik:

sudo ndiswrapper -i ~/Desktop/drivername.inf

Diasumsikan pada perintah diatas bahwa nama berkas .INF Anda adalah

drivername.inf dan disalin ke Desktop. Ganti entri tersebut sesuai dengan yang Anda

miliki.

2. Untuk memeriksa apakah bekerja dengan baik, ketik:

ndiswrapper -l

Jika telah bekerja dengan baik, Anda akan melihat:

Installed ndis drivers:

{name of driver}  driver present, hardware present

3. Agar ndiswrapper berfungsi, Anda harus memuat sebuah modul. Untuk melakukannya, ketik:

http://ndiswrapper.sourceforge.net/mediawiki/index.php/List
ghelp:add-applications#extra-repositories
http://ndiswrapper.sourceforge.net/mediawiki/index.php/list
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sudo depmod -a

sudo modprobe ndiswrapper

4. Untuk memastikan bahwa modul tersebut dimuat setiap kali Anda mem-boot komputer, ketik:

sudo ndiswrapper -m

Sekarang Anda sudah dapat menghubungkan ke internet dengan mengikuti instruksi pada Bagian 1.1,

“Prosedur Dasar” [32] .

1.3. Koneksi ADSL

Semua modem PPPOE dan modem router-style ADSL yang menggunakan koneksi Ethernet telah

didukung oleh Ubuntu, dan juga beberapa modem USB ADSL telah didukung juga.

Untuk modem router-style ADSL, cukup ikuti Bagian 1.1, “Prosedur Dasar” [32]

Untuk informasi bagaimana menyetel modem PPPOE ADSL lihat Bagian 1.3.1, “Modem PPPoE”

[34] .

Untuk informasi bagaimana menyetel modem USB ADSL lihat Bagian 1.3.2, “Modem ADSL USB”

[35] .

1.3.1. Modem PPPoE

Bagian ini adalah mengenai bagaimana menyetel koneksi Internet ADSL menggunakan modem

ethernet PPPoE.

Anda perlu berlangganan ke Internet Service Provider, dan koneksi Internet Anda sudah harus

terinstal dan berfungsi. Anda bisa melihat lampu "DSL" pada modem untuk mengetahui apakah

koneksi telah sinkron.

Anda memerlukan nama pengguna dan kata sandi untuk akun. Dan juga kartu ethernet Anda harus

terhubung ke modem PPPoE melalui jenis kabel yang benar.

Terakhir, Anda perlu menginstal paket PPPoE agar perintah berikut dapat bekerja. Paket ini telah

diinstal secara default, tetapi dapat hilang bila konfigurasi telah berubah. Jika perintah berikut tidak

bekerja, Anda perlu menginstal paket tersebut, yang dapat ditemukan pada CD Ubuntu.

Untuk menyetel modem:

1. Buka Applications->Accessories->Terminal

2. Dalam terminal ketik:

sudo pppoeconf

3. Menu berbasis teks akan memandu Anda untuk menyelesaikan langkah berikut, yaitu:

1. Pastikan bahwa kartu Ethernet Anda telah terdeteksi.

2. Masukan nama pengguna Anda.

3. Masukkan kata sandi Anda.
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4. Jika Anda telah mengkonfigurasi PPPoE Connection sebelumnya, Anda akan ditanya

apakah ingin memodifikasinya.

5. Opsi umum: Anda akan ditanya apakah Anda ingin opsi 'noauth' dan 'defaultroute' atau

ingin menghapus 'nodetach' - pilih "Yes".

6. Use peer DNS - Pilih "Yes".

7. Limited MSS problem - Pilih "Yes".

8. Jika Anda ditanya apakah Anda ingin langsung terhubung saat start up, Anda dapat

menjawab ya.

9. Terakhir Anda akan ditanya apakah Anda ingin langsung mengunakan koneksi tersebut.

4. Setelah Anda menyelesaikan langkan ini, koneksi sudah dapat bekerja.

Untuk menjalankan koneksi ADSL sesuai permintaan, dalam terminal ketik:

sudo pon dsl-provider

Untuk menghentikan koneksi ADSL, dalam terminal ketik:

sudo poff dsl-provider

1.3.2. Modem ADSL USB

Bagian lain dari driver modem ADSL USB adalah proprietary, perangkat lunak closed source, dengan

lisensi terbatas, dan oleh karena itu driver tersebut tidak dapat disediakan di Ubuntu. Agar modem

Anda dapat menggunakan driver ini, silakan download berkas dari Internet melalui komputer lain

yang telah terhubung ke Internet, kemudian pindahkan berkas yang Anda download ke instalasi

Ubuntu Anda.

USB adalah media yang jauh dari ideal untuk akses jaringan, jika Anda memiliki modem

yang dapat terhubung melalui USB dan ethernet atau router ethernet, sebaiknya Anda

menggunakan koneksi ethernet saja daripada menggunakan modem USB.

Karena instalasi modem USB membutuhkan akses Internet untuk men-download driver proprietary

yang dibutuhkan, seperti halnya konfigurasi lebih lanjut yang ada diluar jangkauan panduan ini, yang

kami dapat lakukan hanyalah memberikan daftar model Modem USB yang bekerja dengan Ubuntu

dan juga link ke situs bantuan komunitas Ubuntu untuk mendapatkan instruksi lebih lanjut mengenai

instalasi.

Prosedur instalasi dari modem USB adalah berbeda tergantung dari jenis dan model modem Anda.

Untuk mengetahui model dari modem Anda, catat nama dan nomor dibagian depan. Biasanya Anda

harus melihat label untuk menemukan model yang benar. Lihat daftar di bawah untuk melihat driver

apa yang dibutuhkan oleh modem Anda dan catatan link yang tersedia.

Saat Anda online untuk men-download driver yang dibutuhkan, Anda dapat mengakses link untuk

men-download driver yang ada di halaman dengan instruksi yang dibutuhkan untuk instalasi sesuai

dengan model modem USB tersebut.
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1. Modem Speedtouch

https://help.ubuntu.com/community/UsbAdslModem/SpeedTouch

2. Modem yang menggunakan Analog Devices termasuk eagle-usb I, II atau III chipset (seperti

Sagem Fast 800, Comtrend ct 350 dll.):

https://help.ubuntu.com/community/UsbAdslModem/ueagle-atm

https://help.ubuntu.com/community/UsbAdslModem/EagleUsb

3. Modem berbasis Connexant AccessRunner:

https://help.ubuntu.com/community/UsbAdslModem/EciAdsl

https://help.ubuntu.com/community/UsbAdslModem/AccessRunner

https://help.ubuntu.com/community/UsbAdslModem/AccessRunner

[https://help.ubuntu.com/community/UsbAdslModem/e-techV2]

1.4. Modem Dialup

Kebanyakan modem dialup tidak didukung oleh Ubuntu, tetapi driver dapat ditemukan untuk

mengaktifkan penggunaan modem tersebut. Pertama Anda harus mengidentifikasikan chipset apa

yang modem Anda gunakan.

wget -c http://linmodems.technion.ac.il/packages/scanModem.gz 

gunzip -c scanModem.gz > scanModem 

chmod +x scanModem

sudo ./scanModem 

gedit Modem/ModemData.txt

Baca berkas ini, yang menampilkan chipset modem Anda. Setelah mengetahui chipset yang Anda

miliki, lihat http://www.linmodems.org/ dan ikuti instruksi untuk modem Anda. Informasi lebih lanjut

dapat ditemukan pada halaman SettingUpModems [https://wiki.ubuntu.com/SettingUpModems] di

Wiki Ubuntu.

https://help.ubuntu.com/community/UsbAdslModem/SpeedTouch
https://help.ubuntu.com/community/UsbAdslModem/ueagle-atm
https://help.ubuntu.com/community/UsbAdslModem/EagleUsb
https://help.ubuntu.com/community/UsbAdslModem/EciAdsl
https://help.ubuntu.com/community/UsbAdslModem/AccessRunner
https://help.ubuntu.com/community/UsbAdslModem/e-techV2
http://linmodems.technion.ac.il/packages/scanModem.gz
http://www.linmodems.org/
https://wiki.ubuntu.com/SettingUpModems
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2. Browsing Web

Peramban web yang handal dan aman Mozilla Firefox telah disertakan secara default dalam Ubuntu.

Fitur dari Firefox antara lain tabbed browsing, blok pop-up, fasilitas pencarian, dan live bookmarks.

Juga mendukung plug-in populer seperti Java, Macromedia Flash, dan Real Player. Firefox dapat

diluncurkan dengan mengeklik Applications->Internet->Firefox .

2.1. Menilik Audio dan Video Online dalam Firefox

Untuk melihat stream audio dan video online dalam Firefox, Anda perlu menginstal beberapa plugin.

Plugin yang Anda perlukan tergantung dari media player apa yang Anda pilih (lihat Bagian 4,

“Memutar Video” [23]).

1. Untuk plugin Totem Gstreamer (pemutar media default Ubuntu), instal paket

totem-gstreamer-firefox-plugin dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus

dan Memutakhirkan Aplikasi [9]).

2. Untuk plugin Totem Xine, instal paket totem-xine-firefox-plugin dari repositori “Universe” (lihat

Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

3. Untuk plugin Mplayer, instal paket mozilla-mplayer dari repositori “Multiverse” (lihat Bab 3,

Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

4. Pengaruh perubahan akan terjadi saat Anda menutup dan membuka kembali Firefox.

Langkah berikut akan menginstal plugin untuk Firefox. Akan tetapi, untuk memutar

beberapa format, Anda mungkin harus menambah beberapa codec tambahan (lihat Bagian 5,

“Codec Multimedia” [24]).

2.2. Macromedia Flash untuk Firefox

Untuk menilik grafik flash dari peramban web Mozilla Firefox:

1. Instal paket flashplugin-nonfree dari repositori “Multiverse” (lihat Bab 3, Menambah,

Menghapus dan Memutakhirkan Aplikasi [9]).

2. Plug-in dapat digunakan sesaat Anda menjalankanFirefox kembali.

Instalasi paket yang ada diatas akan men-download dan menginstal plugin. Anda

memerlukan koneksi internet untuk hal ini. Jika, setelah menginstal aplikasi, dan ingin

men-download dan menginstal plugin di waktu lain, masukkan perintah berikut dalam

terminal

sudo update-flashplugin

2.3. Plugin Java untuk Mozilla Firefox

Beberapa situs memerlukan plugin Java untuk Mozilla Firefox. Cara termudah untuk menilik applet

Java adalah dengan menginstal paket j2re1.4-mozilla-plugin dari repositori “Multiverse”.

Untuk instalasi Java secara menyeluruh, lihat Bagian 2, “Java Runtime Environment (1.5)” [64] .
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2.4. NVU Web Authoring System

NVU adalah aplikasi disain web WYSIWYG (What You See Is What You Get), mirip dengan

Dreamweaver.

1. Instal paket nvu dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan Nvu, pilih Applications->Office->Nvu .

2.5. Bluefish Web Development Studio

Bluefish adalah editor untuk perancang dan programer web. Bluefish mendukung banyak bahasa

pemrograman dan bahasa markup, dan menyertakan banyak utilitas untuk perancang dan programer.

1. Instal paket bluefish dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan Bluefish, pilih Applications->Programming->Bluefish Editor
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3. E-mail

3.1. Evolution Mail

Anda dapat menggunakan Evolution untuk menangani e-mail, daftar kontak, tugas dan kalendar.

Aplikasi ini juga berfungsi sebagai pembaca berita dan terintegrasi dengan panel jam Gnome,

memberikan kemudahan akses untuk melihat daftar tugas Anda.

Evolution dapat diluncurkan dengan mengeklik Applications->Internet->Evolution Mail dari sistem

menu desktop.

Jika Anda menginstal Evolution, Anda dapat menemukan panduan bagaimana menggunakan aplikasi

ini di bagian internet [x-yelp-toc:#ApplicationsInternet] dari bantuan ini.

3.2. Klien E-mail Alternatif

Anda dapat juga menggunakanMozilla Thunderbird untuk e-mail. Untuk menginstalnya, silakan instal

paket mozilla-thunderbird (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

Untuk menjalankan Thunderbird, pilih Applications->Internet->Thunderbird Mail Client.

Untuk mengubah klien email yang Anda sukai ke Mozilla Thunderbird:

1. Pilih System->Preferences->Preferred Applications

2. Klik pada tab Mail Reader, dan pilih opsi Custom.

3. Dalam kotak teks Command, ketik  mozilla-thunderbird %s, kemudian tutup dialog.

x-yelp-toc:#ApplicationsInternet
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4. Instant Messaging

4.1. Gaim

Gaim adalah klien pesan cepat default dalam Ubuntu. Dengan Gaim Anda dapat berbicara dengan

teman yang menggunakan AIM/ICQ, Gadu-Gadu, GroupWise, IRC, Jabber, MSN, Napster dan

Yahoo, dan mendaftarkan seluruh teman Anda di dalam satu jendela tunggal.

Untuk menjalankan Gaim, pilih Applications->Internet->Gaim Internet Messenger .

4.2. XChat-GNOME

XChat-GNOME adalah klien Internet Relay Chat (IRC) tingkat lanjut, berbasis grafik, dan dapat

digunakan di banyak platform. Fiturnya yaitu termasuk dukungan penggunaan skrip tingkat lanjut

(perl dan python), antarmuka yang cantik, dan mudah digunakan.

1. Instal paket xchat-gnome dari repositori main (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan XChat-GNOME, pilih Applications->Internet->Xchat-GNOME IRC Chat .

4.2.1. Bergabung ke #ubuntu dengan XChat-Gnome

Salah satu jalan untuk mendapatkan bantuan dengan Ubuntu atau mengenalkan diri sendiri ke IRC

adalah bergabung ke kanal dukungan resmi Ubuntu di Freenode.

1. Jalankan XChat-Gnome seperti di atas.

2. Saat Anda menjalankan XChat-Gnome untuk pertama kali, Anda akan ditanya Nama panggilan

IRC & nama asli Anda. Pilih apa saja yang Anda inginkan untuk nama panggilan (memakai

nama awal & nama akhir cukup bagus, atau Anda bisa lebih kreatif lagi), taruh nama asli Anda,

dan tekan OK.

3. Dalam Jendela Server yang terbuka, pilih Ubuntu Servers, dan tekan Connect.
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5. Peer To Peer

5.1. BitTorrent

Dukungan untuk BitTorrent disertakan dalam Ubuntu secara default. Cari online berkas BitTorrent

.torrent, klik berkas dalam Firefox, dan klien Gnome BitTorrent akan mulai dengan otomatis.

Untuk me-restart download berkas .torrent yang sudah ada di komputer Anda, silakan klik dua kali

pada berkas.

5.2. aMule File Sharing Client

1. Instal paket amule dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk membuka aMule pilih Applications->Internet->aMule .



Internet

42

6. Pembaca Berita

6.1. PPan News Reader

1. Instal paket pan (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

2. Untuk membuka Pan Newsreader, pilih Applications->Internet->Pan Newsreader.

6.2. Pembaca Berita Liferea

1. Instal paket liferea dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk membuka Liferea Feed Reader, pilih Applications->Internet->Liferea Feed Reader.
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7. Networking

7.1. Mengubah Nama Komputer

1. Buka System->Administration->Networking .

2. Klik General, dan masukkan nama komputer dalam ruas Hostname.

Restart komputer agar perubahan dapat berlaku.

7.2. Utilitas Networking

7.2.1. Firestarter Firewall

Firewall melindungi sistem komputer dari akses yang tidak sah. Tidak begitu perlu untuk menginstal

firewall pada sistem Ubuntu, karena akses ke sistem tertutup secara default-nya. Namun, jika Anda

menjalankan services yang mengizinkan komputer lain untuk mengakses komputer Anda (sebagai

contoh, server web Apache), sangat disarankan untuk menginstal firewall. Firestarter adalah program

untuk mengendalikan firewall melalui antarmuka berbasis grafik.

1. Instal paket Firestarter dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Setelah diinstal, jalankan Applications->System Tools->Firestarter untuk menkonfigurasi

firewall Anda. Firewall sekarang akan berjalan di balik layar saat komputer Anda hidup.

7.2.2. Monitor Jaringan Berbasis Grafik

Etherape menayangkan aktifitas jaringan diantara host yang berbeda menggunakan lingkaran dengan

ukuran berbeda.

1. Instal paket etherape dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Pilih: Applications->Internet->Etherape

7.2.3. Penganalisa Lalu Lintas Jaringan

Ethereal adalah penganalisa/pendeteksi lalu lintas jaringan dengan men-capture paket dalam jaringan

secara langsung dan menayangkan isi dari paket tersebut.

1. Instal paket ethereal dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Pilih: Applications->Internet->Ethereal

7.3. Meramban Komputer Jaringan

Untuk menilik komputer di jaringan, buka Places->Network Servers.

Anda perlu memasukkan nama pengguna, kata sandi, dan domain. Anda dapat memperolehnya dari

admin jaringan.
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Bab 6. Aplikasi Kantor
Di Ubuntu tersedia berbagai macam perangkat lunak untuk melakukan pekerjaan kantor — pengolah

kata dan publishing, spreadsheets, dan presentasi.
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1. OpenOffice.org

Di Ubuntu terdapat OpenOffice.org, sebuah program untuk pekerjaan kantor yang di dalamnya

terdapat word processor, spreadsheet, presentation designer, dan database management yang handal.

OpenOffice juga memiliki kompabilitas dengan aplikasi kantoran lainnya, seperti Microsoft Office.

• Situs Web OpenOffice.org [http://www.openoffice.org/]

http://www.openoffice.org/
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2. GNOME Office

Desktop GNOME memiliki kelompok aplikasi kantor. Program ini umumnya lebih ringan dan

lebih cepat daripada program dalam kelompok OpenOffice.org, walaupun mempunyai lebih

sedikit fitur sebagai konsekwensinya. Tetapi aplikasi ini mungkin adalah apa yang Anda butuhkan.

Program-program pada GNOME Office mempunyai kompabilitas dengan kelompok aplikasi kantor

lainnya, seperti Microsoft Office.

Pada GNOME Office Anda akan mendapatkan perangkat lunak berikut ini:

• Aplikasi pengolah kata (Abiword);

• Aplikasi spreadsheet (Gnumeric);

• Program manajemen database (GNOME-DB);

• Editor diagram (Dia);

• Dua aplikasi grafik (Inkscape dan The GIMP); dan

• Aplikasi manajemen proyek (Planner).

Tiap aplikasi tersebut juga dapat diinstal secara terpisah

Untuk menginstal program GNOME Office:

1. Instal paket gnome-office dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Aplikasi-aplikasi kantor dapat ditemukan dalam menu pada Applications->Office, dan

aplikasi-aplikasi Grafik dapat ditemukan pada Applications->Graphics.
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3. Aplikasi Akuntansi GnuCash

GnuCash adalah program untuk mengelola keuangan pribadi dan bisnis Anda. Dengan GnuCash Anda

dapat mengelola akun bank, saham, pendapat dan pengeluaran. Cepat dan intuitif seperti checkbook

register, aplikasi ini menggunakan prinsip akuntansi profesional untuk memastikan neraca seimbang

dan membuat laporan yang akurat.

• Situs Web GnuCash [http://gnucash.org/]

Untuk menggunakan GnuCash:

1. Instal paket gnucash dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Anda dapat membuka GnuCash dengan menjalankan perintah gnucash (lihat manual

menjalankan aplikasi [ghelp:user-guide#tools-run-app] untuk bantuan bagaimana menjalankan

aplikasi tanpa melalui menu). Jika menginginkannya, Anda dapat menambah entri menu untuk

program gnucash (lihat manual penyuntingan menu [ghelp:user-guide#menu-editor] untuk

bantuan bagaimana menambah entri menu).

http://gnucash.org/
ghelp:user-guide#tools-run-app
ghelp:user-guide#tools-run-app
ghelp:user-guide#menu-editor
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4. Aplikasi Scribus Desktop Publishing

Scribus adalah program desktop publishing profesional. Untuk informasi lebih lanjut, lihat situs web

Scribus [http://www.scribus.org.uk/].

1. Instal paket scribus (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

2. Untuk menginstal templat tambahan, instal paket scribus-template dari repositori “Universe”

(lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

Anda harus menggunakan Synaptic Package Manager untuk menginstal paket ini

3. Untuk menjalankan Scribus, pilih Applications->Office->Scribus .

http://www.scribus.org.uk/
http://www.scribus.org.uk/
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Bab 7. Grafik & Foto
Bagian ini menguraikan manajemen foto dan aplikasi untuk disain grafis yang tersedia untuk

digunakan dalam Ubuntu, dan menguraikan bagaimana menyetel peranti grafik 3d.
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1. Kamera Digital

Kebanyakan kamera digital USB sudah otomatis terdeteksi oleh Ubuntu. Cukup colok dan nyalakan

kamera digital USB Anda. Ubuntu kemudian akan menanyakan apakah Anda ingin mengimpor

foto dari kamera. Klik Import, Ubuntu akan menampilkan preview foto tersebut. Pilih lokasi untuk

menyimpan foto, kemudian klik Import, Ubuntu kemudian akan menyimpan foto Anda ke dalam hard

drive.

Jika tidak keluar pertanyaan untuk mengimpor foto Anda:

1. Buka Applications->Graphics->gThumb Image Viewer .

2. Pilih File->Import Photos.

Lihat Bagian 3, “gThumb Image Viewer” [53]  untuk informasi lebih lanjut mengenai gThumb.
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2. Kartu Grafik 3D

2.1. Pengenalan ke Akselerasi Video 3D

Kebanyakan perangkat keras video akan langsung bekerja secara otomatis dalam Ubuntu. Akan tetapi

beberapa tipe dari perangkat keras video, akselerasi 3D (dibutuhkan oleh beberapa permainan) tidak

didukung secara otomatis, tetapi Anda dapat memperbaiki hal ini sendiri.

Untuk mengetahui apakah akselerasi 3D acceleration sudah berkerja atau tidak, ketikan dalam

terminal:

glxinfo | grep rendering

Jika akselerasi 3D sudah bekerja, hasilnya akan seperti ini:

direct rendering: Yes

Jika tidak, ikuti instruksi berikut untuk mengaktifkan akselerasi 3D.

2.2. Driver Kartu Video Nvidia 3D

Di Ubuntu dukungan akselerasi 3D pada kartu Video Nvidia tidak diaktifkan secara otomatis, karena

pabrik pembuatnya tidak merilis driver source drivers. Akan tetapi Anda dapat mengaktifkan sendiri

akselerasi 3D tersebut. Proses ini tergantung pada jenis dari kartu video yang Anda miliki.

• Jika Anda memiliki kartu grafik lama seperti TNT, TNT2, TNT Ultra, GeForce1 atau GeForce2,

instal paket nvidia-glx-legacy dan nvidia-settings dari repositori “Restricted” (lihat Bab 3,

Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

• Jika Anda memiliki kartu grafik terbaru, instal paket nvidia-glx dari repositori “Restricted” (lihat

Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

Untuk menyetel driver baru, masukkan dalam terminal:

sudo nvidia-glx-config enable 

Anda dapat menyesuaikan setting dari driver baru dengan menjalankan nvidia-settings(lihat manual

menjalankan aplikasi [ghelp:user-guide#tools-run-app] untuk bantuan bagaimana menjalankan

aplikasi tanpa melalui menu). Jika menginginkannya, Anda dapat menambah entri menu untuk

program ini (lihat manual penyuntingan menu [ghelp:user-guide#menu-editor] untuk bantuan

bagaimana menambah entri menu).

2.3. Driver Kartu Video ATI 3D

Banyak kartu video ATI yang bekerja baik secara otomatis pada Ubuntu. Untuk memeriksa apakah

akselerasi 3D sudah bekerja, lihat Bagian 2.1, “Pengenalan ke Akselerasi Video 3D” [51] .

Jika tidak bekerja:

ghelp:user-guide#tools-run-app
ghelp:user-guide#tools-run-app
ghelp:user-guide#menu-editor
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1. Instal paket xorg-driver-fglrx dari repositori “Restricted” (lihat Bab 3, Menambah, Menghapus

dan Memutakhirkan Aplikasi [9]).

2. Untuk menyetel driver baru, masukkan dalam terminal:

sudo dpkg-reconfigure xserver-xorg

Pilih otomatis mendeteksi kartu video Anda, dan pilih driver fglrx saat ditanyakan.

Restart komputer agar perubahan dapat terjadi.
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3. gThumb Image Viewer

gThumb adalah penilik dan peramban gambar tingkat lanjut. Mempunyai banyak fitur, seperti

dapat meramban sistem berkas, salin salindia, katalog gambar, membuat album foto, impor kamera,

membakar CD gambar, memproses beberapa berkas sekaligus, dan fitur menyunting gambar dengan

cepat seperti transformasi dan manipulasi warna.

gThumb disertakan secara default di Ubuntu. Untuk menjalankannya, pilih

Applications->Graphics->gThumb Image Viewer .

Untuk mencari bantuan seputar gThumb, gunakan item yang ada di menu Help.

Untuk penyuntingan foto & gambar tingkat lanjut, lihat The GIMP.
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4. The GIMP (Gnu Image Manipulation Program)

Dengan GIMP Anda dapat menggambar, mewarnai, menyunting gambar, dan banyak lagi! GIMP

menyertakan beberapa fungsi dan plug-in dari program penyuntingan dan pengolahan gambar lainnya.

The GIMP telah terinstal secara default di Ubuntu, dan dapat dijalankan dengan memilih

Applications->Graphics->GIMP Image Editor .

• Situs Web GIMP [http://gimp.org/]

http://gimp.org/
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5. Inkscape Vector Graphics Editor

Inkscape adalah editor untuk gambar dengan format SVG (Scalable Vector Graphics).

1. Instal paket inkscape (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan Inkscape pilih Applications->Graphics->Inkscape SVG Vector Illustrator .
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6. Blender 3d Modeller

Blender adalah suite 3d untuk modelling, animasi, rendering, post-produksi, menciptakan gambar

interaktif dan untuk memutar berkas 3d.

1. Instal paket blender (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan Blender pilih Applications->Graphics->Blender 3d modeller.
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Bab 8. Permainan
Di Ubuntu telah tersedia 16 permainan, meliputi Aisleriot Solitaire, Gnometris, dan Mines.

Telusuri menu permainan Ubuntu pada Applications->Games .
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1. Frozen-Bubble

Dalam Frozen-Bubble Anda diharuskan menembak kumpulan gelembung dengan warna yang sama

agar bisa membuatnya meledak.

1. Instal paket frozen-bubble dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan Frozen-Bubble, pilih Applications->Games->Frozen-Bubble.
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2. PlanetPenguin Racer

Race Tux, maskot Linux, menuruni gunung bersalju dan ditutupi oleh es dengan secepat mungkin,

hindari pohon dan gunung yang akan memperlambat jalan Anda.

Pastikan Anda memiliki driver akselerasi 3D untuk kartu video telah terinstal. Untuk

informasi lebih lanjut lihat Bagian 2, “Kartu Grafik 3D” [51].

1. Instal paket planetpenguin-racer dari repositori “Universe” (lihat Bab 3, Menambah, Menghapus

dan Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan PlanetPenguin Racer, pilih Applications->Games->PlanetPenguin-Racer.
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3. Scorched3D

Scorched3D adalah versi 3D untuk Scorched Earth, sebuah permainan pertarungan artileri.

Pastikan Anda memiliki driver akselerasi 3D untuk kartu video telah terinstal. Untuk

informasi lebih lanjut lihat Bagian 2, “Kartu Grafik 3D” [51].

1. Install the scorched3d package from the “Universe” repository (see Bab 3, Menambah,

Menghapus dan Memutakhirkan Aplikasi [9]).

2. Untuk menjalankan Scorched3D, pilih Applications->Games->scorched 3d.
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4. Permainan Windows

Banyak permainan yang tersedia untuk Windows dapat dijalankan pada Linux melalui emulator.

Contoh dari emulator adalah Wine dan Cedega

1. Informasi mengenai Wine, silakan lihat wiki Ubuntu [https://help.ubuntu.com/community/Wine].

2. Informasi mengenai Cedega, silakan lihat wiki Ubuntu

[https://help.ubuntu.com/community/Cedega].

https://help.ubuntu.com/community/Wine
https://help.ubuntu.com/community/Cedega
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Bab 9. Pemrograman
Bagian ini memuat beberapa informasi dasar untuk Anda yang ingin menggunakan Ubuntu untuk

menulis dan menjalankan program Anda sendiri.
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1. Compiler Pokok

Untuk meng-compile program dibutuhkan beberapa paket yang tidak diinstal secara default. Anda

dapat menginstal seluruh paket ini sekaligus dengan menginstal paket build-essential (lihat Bab 3,

Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).
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2. Java Runtime Environment (1.5)
Instruksi ini adalah hanya untuk komputeri386 dan amd64. Untuk mesin PowerPC, lihat

Bantuan Online Ubuntu [https://help.ubuntu.com/community/Java].

Pada saat penulisan J2SE yang ada adalah versi 5.0 Update 6. Hal ini dapat berubah setiap

saat. Jika pada situs Sun Anda tidak melihat versi ini, silakan download versi terbaru yang

ada.

1. Kunjungi http://java.sun.com/j2se/1.5.0/download.jsp dan klik di “Download JRE 5.0 Update 6”.

Jangan pilih link JRE dengan bundel NetBeans.

2. Pertama Anda harus menyetujui lisensi, kemudian klik di “Linux self-extracting file” dan

Download jre-1_5_0_06-linux-i586.bin ke hard drive Anda.

Jika Anda menggunakan komputer amd64, silakan ganti jre-1_5_0_06-linux-i586.bin

dengan jre-1_5_0_06-linux-amd64.bin.

3. Instal paket java-package dari repositori “Multiverse” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

4. Untuk membuat berkas yang telah di-download dapat dieksekusi. Pada baris perintah, pindah ke

direktori dimana Anda men-download berkas, dan ketik

chmod +x jre-1_5_0_06-linux-i586.bin

5. Untuk menginstal JRE, pertama Anda harus membuat paket Ubuntu. Ketik

fakeroot make-jpkg jre-1_5_0_06-linux-i586.bin

6. Kemudian instal paket yang Anda buat:

sudo dpkg -i sun-j2re1.5_1.5.0+update06_i386.deb

7. Agar sistem Anda menggunakan Sun Java daripada aplikasi open-source GIJ yang diinstal secara

default, jalankan:

sudo update-alternatives --config java

dan pilih opsi yang memuat j2re1.5-sun.

https://help.ubuntu.com/community/Java
http://java.sun.com/j2se/1.5.0/download.jsp
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3. Perkakas Pengembangan

Berikut adalah beberapa Integrated Development Environments (IDEs), editor, dan perkakas

pengembangan lainnya yang tersedia untuk Ubuntu.

• Anjuta [http://anjuta.sourceforge.net/] adalah Lingkungan Pengembangan Terpadu (IDE) untuk C

dan C++.

• Bazaar-NG [http://www.bazaar-ng.org/] adalah de-sentralisasi sistem kontrol versi yang

digunakan untuk pengembangan Ubuntu.

• Bluefish [http://bluefish.openoffice.nl/index.html] adalah editor handal untuk perancang dan

programer web berpengalaman.

• Eclipse [http://www.eclipse.org/] adalah IDE untuk Java dan bahasa pemrograman lainnya. Mirip

dengan program closed-source seperti JBuilder.

• Eric [http://www.die-offenbachs.de/detlev/eric3.html] adalah IDE untuk Python dan Ruby.

• Glade [http://glade.gnome.org/] adalah perancang Antarmuka Pengguna untuk membangun

aplikasi GNOME.

• IDLE [http://www.python.org/idle/] adalah IDE untuk Python yang dibangun dari Tkinter GUI

toolkit.

• KDevelop [http://www.kdevelop.org/] adalah IDE untuk KDE yang mendukung banyak bahasa

pemrograman.

• MonoDevelop [http://www.monodevelop.com/Main_Page] adalah IDE untuk menulis aplikasi

mono/.net dalam bahasa C# dan lainnya.

• NetBeans [http://www.netbeans.org/index.html] adalah IDE untuk Java dengan fitur seperti

mendukung CVS dan pembuatan form.

http://anjuta.sourceforge.net/
http://www.bazaar-ng.org/
http://bluefish.openoffice.nl/index.html
http://www.eclipse.org/
http://www.die-offenbachs.de/detlev/eric3.html
http://glade.gnome.org/
http://www.python.org/idle/
http://www.kdevelop.org/
http://www.monodevelop.com/Main_Page
http://www.netbeans.org/index.html
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4. Mempelajari Bagaimana Membuat Program

4.1. Dive Into Python

Dive Into Python adalah sebuah untuk mempelajari bagaimana membuat program dalam Python,

ditujukan untuk pemprogram yang telah memiliki pengalaman.

• Baca Dive Into Python [file:///usr/share/doc/diveintopython/html/toc/index.html]

4.2. Tutorial PyGTK

Tutorial PyGTK adalah tutorial mengembangkan aplikasi dengan toolkit berbasis grafik yang

sering digunakan untuk mengembangkan aplikasi Ubuntu. Pada buku ini Anda diasumsikan sudah

mempunyai pengetahuan tentang Python.

1. Instal paket python-gtk2-tutorial (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan

Aplikasi [9]).

Anda harus menggunakan Synaptic Package Manager untuk menginstal paket ini

2. Untuk mengakses dokumentasi, kunjungi python-gtk-tutorial

[file:///usr/share/doc/python-gtk2-tutorial/html/index.html].

4.3. Devhelp

Devhelp adalah aplikasi untuk membaca dan mencari seluruh dokumentasi yang Anda instal.

1. Instal paket devhelp (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

2. Pilih: Applications->Programming->Devhelp.

file:///usr/share/doc/diveintopython/html/toc/index.html
file:///usr/share/doc/python-gtk2-tutorial/html/index.html
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Bab 10. Partisi dan Booting
Bagian ini memuat informasi bagaimana mengubah cara komputer Anda bertindak sesaat Anda

menyalakannya untuk pertama kali, dan bagaimana mengakses sistem operasi dan partisi lain dari

Ubuntu.
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1. Editor Grafik Untuk Partisi

Gparted adalah perkakas berbasis grafik untuk menyunting partisi cakram keras.

1. Instal paket gparted (lihat Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]).

2. Anda dapat menjalankan aplikasi dengan System->Administration ->Gnome Partition Editor .



Partisi dan Booting

69

2. Membuat partisi Windows dapat terbaca dari Ubuntu

Partisi Windows seharusnya sudah terbaca secara otomatis dari sistem Ubuntu. Jika ternyata belum,

Anda dapat membuatnya agar bisa terbaca dengan menggunakan Disks Manager.

1. Buka System->Administration->Disks .

2. Pilih hard disk yang sesuai, dan klik Partitions.

3. Pilih partisi yang sesuai, dan klik Enable.

4. Untuk meng-unmount partisi, klik Disable.
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3. Membuat partisi Windows terbaca secara otomatis

Partisi Windows seharusnya sudah terbaca secara otomatis dari Ubuntu. Jika ternyata belum, prosedur

berikut akan membuat partisi menjadi terbaca secara otomatis:

1. Baca Bagian 7.1, “Memeriksa penggunaan kapasitas cakram dan menilik tabel partisi” [74]

2. Pertama buat direktori dimana partisi tersebut akan dibaca ("mounted"):

sudo mkdir /media/windows

       

3. Sekarang, backup berkas konfigurasi cakram padat Anda dan buka berkas di dalam editor teks

dengan hak akses administratif:

sudo cp /etc/fstab /etc/fstab_backup

sudo gedit /etc/fstab

      

4. Tambahkan baris berikut di bagian akhir berkas:

/dev/hda1 /media/windows ntfs umask=0222 0 0

Ganti /dev/hda1 dengan nama peranti yang sesuai untuk partisi Anda.

Jika partisi Windows Anda menggunakan sistem berkas FAT32, ganti ntfs dengan vfat

dalam perintah di atas.

Jika Anda mempunyai sistem berkas FAT32, sangat aman untuk mengizinkan akses

baca-tulis. Untuk melakukan hal ini ubah nilai umask menjadi 0000.

5. Simpan berkas (contoh [sample/fstab_automountntfs]).

6. Perubahan akan berpengaruh sesudah komputer di-restart.

sample/fstab_automountntfs
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4. Menjalankan perintah sistem secara otomatis saat startup

Terkadang sangat berguna untuk menjalan perintah custom kapan saja saat komputer Anda starts up.

Untuk melakukan ini:

1. Sunting crontab dengan hak akses administratif (lihat Bab 2, Pekerjaan Administratif [8]):

sudo crontab -e

2. Masukkan baris berikut:

@reboot /home/user/command

Ganti /home/user/command dengan alamat lengkap ke perintah Anda.

3. Simpan berkas dan keluar.
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5. Mengubah sistem operasi baku saat boot

Untuk mengubah sistem operasi mana yang digunakan secara default saat komputer starts up, sunting

berkas konfigurasi grub.

1. Buat backup dari berkas konfigurasi, dan kemudian buka dalam editor teks:

sudo cp /boot/grub/menu.lst /boot/grub/menu.lst_backup

sudo gedit /boot/grub/menu.lst

2. Cari baris ini:

...

default 0

...

3. Ganti dengan baris berikut:

default X

Anda harus mengganti X dengan angka, sesuai dengan urutan sistem operasi mana

yang ada dalam berkas konfigurasi. Perhitungan dimulai dari 0. Sebagai contoh, jika

Anda ingin default sistem operasi adalah yang ada dari baris pertama, ganti X dengan

0. Jika ingin default sistem operasi adalah yang berada di baris kedua, ganti X dengan

1, dan seterusnya.

4. Simpan berkas (contoh [sample/menu.list_changedefaultosgrub])

sample/menu.list_changedefaultosgrub
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6. Mengkonfigurasi startup services

Tugas ini membutuhkan hak akses administratif (see Bab 2, Pekerjaan Administratif [8]).

1. Jalankan Services Settings: System->Administration->Services.

2. Masukkan kata sandi Anda.

3. Pilih service yang ingin dijalankan, kemudian klik OK bila selesai.

4. Untuk kendali yang lebih besar pada boot-up services, instal bum dari repositori“Universe” (lihat

Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]), dan untuk menjalankannya:

System->Administration->Boot-up Manager.
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7. Tip Lainnya

7.1. Memeriksa penggunaan kapasitas cakram dan menilik tabel partisi

1. Buka System->Administration->Disks .

2. Pilih Harddrive, kemudian tab Partitions

3. Setiap partisi terlihat dalam Partition List, dengan kapasitas cakram dan lokasi mount.

7.2. Daftar peranti

Untuk melihat daftar peranti yang di-mount, dalam terminal ketik:

mount

Daftar ini menampilkan peranti (seperti partisi hard disk), lokasi mount (dimana Anda mengakses

berkas), jenis sistem berkas dan opsi untuk mount.

Contoh ini menampilkan partisi hard disk hda2 yang di-mount sebagai '/', dengan jenis sistem

berkas ext3. Partisi di-mount dengan dua opsi, satu untuk mengizinkan peranti untuk dibaca dari dan

ditulis ke dan opsi yang lain akan me-remount peranti untuk hanya dapat dibaca saja apabila terjadi

kesalahan.

/dev/hda2 on / type ext3 (rw,errors=remount-ro)

Untuk melihat daftar peranti PCI:

lspci

Untuk melihat daftar peranti USB:

lsusb

7.3. Mount/unmount CD/DVD-ROMs secara manual, dan menampilkan

seluruh berkas/folder tersembunyi dan yang berhubungan dengannya

Diasumsikan bahwa /media/cdrom0/ adalah lokasi dari CD/DVD-ROM

Untuk me-mount CD/DVD-ROM:

sudo mount /media/cdrom0/ -o unhide

Untuk meng-unmount CD/DVD-ROM:

sudo umount /media/cdrom0/
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Bab 11. Pencetak
Beberapa printer akan terdeteksi secara otomatis oleh Ubuntu; bagi yang tidak terdeteksi, pilih

System->Administration->Printing , kemudian pilih Printer->Add Printer.

Beberapa printer memerlukan pengaturan lebih lanjut. Cari database pada

LinuxPrinting.org [http://www.linuxprinting.org/] atau periksa halaman Wiki Ubuntu

[https://wiki.ubuntu.com/HardwareSupportComponentsPrinters] untuk informasi tambahan mengenai

printer Anda.

http://www.linuxprinting.org/
https://wiki.ubuntu.com/HardwareSupportComponentsPrinters
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Bab 12. Konfigurasi Desktop Tingkat

Lanjut
Bagian ini menjelaskan beberapa tips untuk menggunakan dan meng-customize lingkungan desktop

Ubuntu (yaitu GNOME), dan aplikasi file manager (yaitu Nautilus).
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1. Login secara otomatis saat komputer nyala

Login secara otomatis sesaat komputer nyala:

1. Pilih System->Administration->Login Window .

2. Pilih Security, dan nyalakan Enable Automatic Login.

3. Pilih akun yang Anda ingin pergunakan untuk login.

Tidak dianjurkan untuk kebanyakan komputer, karena hal ini tidak aman dan akan memberikan akses

kepada orang lain ke komputer Anda.
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2. Membuka berkas dari file manager dengan hak akses

administratif

Untuk membuka berkas dengan hak akses administratif dari file manager, Anda harus menambahkan

skrip ke Nautilus.

Membuka berkas dengan hak akses administratif mengandung resiko keamanan. Pastikan

selalu Anda sudah mengenali berkas yang Anda akan buka.

1. Buka berkas baru untuk disunting di direktori:

gedit $HOME/.gnome2/nautilus-scripts/Open\ as\ Administrator

2. Masukkan baris ini dalam berkas baru:

for uri in $NAUTILUS_SCRIPT_SELECTED_URIS; do

gksudo "gnome-open $uri" &

done

3. Simpan berkas (contoh [sample/nautilus_open_as_administrator])

4. Membuat berkas agar bisa dieksekusi:

chmod +x $HOME/.gnome2/nautilus-scripts/Open\ as\ Administrator

Sekarang Anda dapat membuka berkas sebagai admin dengan mengeklik kanan berkas dan pilih

Scripts->Open as Administrator.

sample/nautilus_open_as_administrator
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3. Menginstal Huruf Tambahan

Bagian ini menjelaskan bagaimana menginstal huruf tambahan dari arsip Ubuntu.

Untuk international fonts, instal paket ini dari repositori “Universe” (lihat Bab 3, Menambah,

Menghapus dan Memutakhirkan Aplikasi [9]):

• xfonts-intl-arabic

• xfonts-intl-asian

• xfonts-intl-chinese

• xfonts-intl-chinese-big

• xfonts-intl-european

• xfonts-intl-japanese

• xfonts-intl-japanese-big

• xfonts-intl-phonetic

Untuk Microsoft TrueType core fonts, instal paket msttcorefonts dari repositori “Multiverse” (lihat

Bab 3, Menambah, Menghapus dan Memutakhirkan Aplikasi [9]):

Untuk huruf Ghostscript, instal paket gsfonts-x11 (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

Setelah menginstal setiap huruf baru, bangun ulang berkas informasi huruf dengan menjalakan

perintah ini dalam Terminal:

sudo fc-cache -f -v

Jika Anda lebih suka men-download huruf secara manual, Anda dapat dengan mudah menginstalnya

dengan membuka file manager, dan mengetik fonts:/// di dalam location bar (lihat manual file

manager [ghelp:user-guide#nautilus-location-bar] untuk bagaimana menggunakan location bar).

Kemudian Anda cukup men-drag huruf yang telah di-download ke dalam kumpulan huruf yang telah

ada.

ghelp:user-guide#nautilus-location-bar
ghelp:user-guide#nautilus-location-bar
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4. RAR Archiver
1. Instal paket rar dari repositori “Multiverse” (lihat Bab 3, Menambah, Menghapus dan

Memutakhirkan Aplikasi [9]).

2. Jalankan:

sudo ln -fs /usr/bin/rar /usr/bin/unrar

3. Untuk membuka berkas rar, klik dua kali pada berkas.
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5. Advanced Desktop Applets

gDesklets adalah sistem untuk menampilkan program mini (desklets), seperti ramalan cuaca, berita

terkini, menayangkan informasi sistem, atau sebagai kendali pemutar musik di atas desktop Anda.

1. Instal paket gdesklets dan gdesklets-data dari repositori “Universe” (lihat Bab 3, Menambah,

Menghapus dan Memutakhirkan Aplikasi [9]).

2. Pilih: Applications->Accessories->gDesklets

3. Untuk informasi lebih lanjut, kunjungi situs web gDesklets [http://www.gdesklets.org/]

http://www.gdesklets.org/
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6. Menyembunyikan Recent Documents dalam menu Places

Untuk menyembunyikan Recent Documents dari menu Places, buka terminal dan jalankan perintah:

chmod 400 ~/.recently-used

Untuk menampilkan menu lagi, jalankan perintah:

chmod 600 ~/.recently-used
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7. Menampilkan ikon desktop Computer, Home dan Trash di

GNOME
1. Buka Configuration Editor, dengan menjalankan program gconf-editor (lihat manual

menjalankan aplikasi [ghelp:user-guide#tools-run-app] untuk bantuan bagaimana menjalankan

aplikasi tanpa melalui menu).

2. Pilih apps->nautilus->desktop.

3. Tandai bagian computer_icon_visible, home_icon_visible, and trash_icon_visible. Perubahan

akan langsung terjadi.

ghelp:user-guide#tools-run-app
ghelp:user-guide#tools-run-app
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8. Restart GNOME tanpa perlu me-reboot komputer
1. Simpan dan tutup semua aplikasi yang dibuka.

2. Gunakan shortcut Ctrl-Alt-Backspace untuk me-restart GNOME.

3. Jik Ctrl-Alt-Backspace dinonaktifkan, ketik

sudo /etc/init.d/gdm restart

(Lihat Bagian 9, “Mencegah shortcut Ctrl-Alt-Backspace yang dapat me-restart X” [85]

untuk menonaktifkan Ctrl-Alt-Backspace.)
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9. Mencegah shortcut Ctrl-Alt-Backspace yang dapat

me-restart X
1. Buat salinan dari berkas /etc/X11/xorg.conf yang ada:

sudo cp /etc/X11/xorg.conf /etc/X11/xorg.conf_backup

2. Buka /etc/X11/xorg.conf untuk menyunting:

sudo gedit /etc/X11/xorg.conf

3. Tambah berkas berikut di akhir berkas:

Section "ServerFlags"

Option "DontZap" "yes"

EndSection

4. Simpan berkas yang telah disunting (contoh [sample/xorg.conf_disablectrlaltbackspacegnome]).

5. Perubahan baru berpengaruh waktu nanti Anda login kembali ke GNOME. Jika Anda ingin

perubahan langsung berpengaruh, restart GNOME secara manual. (Lihat Bagian 8, “Restart

GNOME tanpa perlu me-reboot komputer” [84].)

sample/xorg.conf_disablectrlaltbackspacegnome

